
    Championship Spades 1.31 Help (Unregistered)

C  HAMPIONSHIP   S  PADES   - T  IPS     ON     USING     THIS     PROGRAM  
General help
Picking your favorite game variation
Different computer play styles
Customizing images and sounds
Will there be a multi-player network version?
Registering
Contacting the author
Version history
Known bugs and possible workarounds

S  PADES   B  ASICS   - B  ASIC     RULES     OF     THE     GAME  
Cards
Trump
Bidding
Playing
Scoring
Game Variations and Sandbags
Going Nil

M  ASTERING   S  PADES   - A   TUTORIAL     FOR     ADVANCED     PLAYERS  
** ONLY IN REGISTERED VERSION **
Chapter 1: Bidding better and signaling
Chapter 2: Playing to maximize tricks
Chapter 3: Setting them AND minimizing bags
Chapter 4: Review and Quiz
Chapter 5: NIL: bid, play, protect, sink
Chapter 6: Advanced end-game strategies
Chapter 7: Test of Spades Mastery



    Championship Spades general help

What makes Championship Spades different?
Championship Spades specializes in Spades for the championship player who seriously 
enjoys the game, offering:

-=- Colorful, fast, non-cluttered, and polished interface.
-=- Selectable, customizable computer personalities with different styles.
-=- Expert computer players who will cover, sink, signal, etc..
-=- Many game variations and image/sound customization.
-=- Both 16-bit and 32-bit versions for Win 3.1, OS/2, Win 95, and NT.

General help
Bidding - To bid your hand, click on the appropriate card in the bid window corresponding 
to the number of tricks you can take when the arrow points to you.    It also possible to bid 
by entering the number corresponding to your bid on the keyboard.

Playing - To play your hand, click on the appropriate card in your hand that you wish to 
play when the arrow points to you. It also possible to bid by entering the number 
corresponding to your card on the top row of keyboard (1-9,0, - for 11, and = for 12).

Options - To change the game options for various Spades variations, select them under 
the options menu.    For more details on the game options available, click on the next 
button.

Players - To change the personalities of your computer opponents, select Player… under 
the Options menu.    For more details on the personalities, click on the next button.

Tables and decks - To select a different table or deck patern, select them under the 
Options menu.    It is also possible to use the numeric keys to select a table or deck 
pattern.

Practice features - Various items under the Practice menu will allow you to take back a 
play, redeal, rebid, or replay a hand.    You can also assign specific cards to players or let 
the computer playout an obvious hand for you.    You can also view a play history window 
or all players cards if you want to analyze a hand in-depth.

Save/print/restore - Finally, you may save, restore, and print hands and play history 
under the File menu or via a button on the hand summary dialog.    This will allow you to 
print or save particularly interesting hands and to load the hands described in the 
Mastering Spades advanced tutorial.

Also - See Spades Basics and Mastering Spades



    Picking your favorite game variation
Championship Spades offers extensive customization to support different game variations 
which affect both game play and scoring.

Game options
Name prompt on startup - Change this to No to disable the name prompt on game 
startup.    You can still change your name at any time under Options menu and the previous
name used will be restored the next time you play.

Game speed - Ranges from Slow to Fast affect how quickly the game play operates.    
Note that at the Fast level, many of the play sounds, indicator updates, and animations are
disabled or abbreviated.    Most people should be happy with the Normal speed.

Score w/hash marks - Change this to No if you prefer numbers instead of hash marks 
when recording tricks bid and taken on the trick card.

Confirm practice options - Change this to No if you want to use the Practice options 
(take back, hint, redeal, rebid, replay, and view history) without being prompted first.

Confirm bids and plays - Change this to Yes if you want every bid and play you make to 
be confirmed before it is made.

Personality for hints - Change this to the computer personality name that you wish to 
provide you hints for bidding and playing.    If you are more recreational player, you should 
probably choose a strong intermediate player like ProfPlum, as an expert player (Red, 
LadyLuck, and Sparky) may suggest bids and plays that may confuse you.    For more 
details, see Selecting a Computer Personality

Cutthroat (no partners) - Change this to yes if you wish to play cutthroat.    In cutthroat, 
every player is for themselves and there are no partners.    This can change play 
dramatically and makes it very difficult to get a Nil.

Overtricks count as bags - Change this to no if you do not want to play with sandbags.    
Most players play that overtricks count as sandbags.    Once a certain number of bags are 
accumulated (usually 10), the player is penalized (usually 100 points).    Sandbags help 
prevent players from consistently underbidding.

Count bags won by Nil - Change this to yes if you want bags to count against a Nil bid.    
Normally, if a player does not get their Nil bid, their tricks do not count as bags.

Who gets the first lead - Change this to High bidder if the highest bidder should get the 
first lead.    Change this to Two of clubs if the player with the two of clubs should always get
the lead.    Note that chosing this option also forces all players to play their lowest club on 
the first trick.    This variation is true to the original and official Spades rules.    Finally, the 
most common is the Dealers left option which has the player to the dealers left leading for 
the first trick.

2S beats Ace of Spades - Change this to yes if you want the Two of Spades to be the 
highest Spade (over the Ace).    Note that this option is currently under development and 
since I have not received any requests to provide it, I may never add it.

Play with high/low jokers - Change this to yes if you want to replace the Two of Hearts 
and Two of Diamonds with a high and low joker.    These jokers will beat any other Spade 



(including the Two or Ace, whichever is higher).    Note that this option is currently under 
development and since I have not received any requests to provide it, I may never add it.

Scoring options
Minimum bid required - Set this to minimum bid required.    This is usually 1 or 2.    Note 
that the minimum bid applies only to each player, not to both partners as some variations 
play.    If you want minimum bids based on partners combined bids, let me know.

10 trick bid/got bonus - Set this to the bonus amount if a team bids AND wins 10 or 
more tricks.    Set this to 0 if you do not want a bonus.    Set this to 100 for the common 10 
for 200 variation (since the 10 tricks are already worth 100).

Slam (all 13) bonus - Set this to the bonus amount if a team wins all 13 tricks (regardless
of their bid).    Set this to 0 if you do not want a bonus.    200 is usually a fair bonus which 
will usually assure the players a win in the current game.

10 bags total penalty - Set this to the penalty when a player or team accumulates 10 
bags. Note that penalties have a minus in them.    This is usually -100.

Overtrick penalty after - Set this to the number of overtricks after which a penalty is 
charged.    This less common method of addressing consistent underbidding is usually an 
alternative to playing with bags.    Set this to 13 to assure that no overtrick penalty is used.

Overtrick penalty - Set this to the penalty charged when the number of overtricks set in 
the last option are won.    Generally this is -40.

Game played until - Set this to the game ending score.    Partnership games usually are 
played to 500 and cutthroat games to 300.

Trick bid and won - Set this to the number of points a bid and won trick is worth.    This is 
almost always 10.

Trick bid and lost - Set this to the number of points a bid and lost trick is worth.    This is 
almost always -10.

Nil bid and won - Set this to the number of points a bid and won trick is worth.    This is 
almost always 100.

Nil bid and lost - Set this to the number of points a bid and won trick is worth.    This is 
almost always -100.

Overtricks are worth - Set this to the number of points an overtrick is worth (trick won 
over the bid).    This is almost always 1.



    Different computer play styles
One of the unique strengths of Championship Spades is the variety of computer play styles 
you can play against.    Each computer personality bids and plays differently.    You may select
which players you wish to play with under the Players… option on the Options menu.    In this
dialog you may right-click on any players face to get details on the that players play style.    
You can then select the player by clicking on the player.    The positions at the bottom of the 
dialog indicate which position each player will be in.    In particular, note that the North 
position will be your partner in Partnership Spades so this player should probably play with a
similar skill level and aggressiveness to yourself.    Specifically, each computer player has 
four attributes which affect their bidding and game play:

Skill - This central attribute assesses the players skill level in Spades.    For example, 
beginners will generally bid by just counting Aces and Kings.    Expert players will look at 
distribution and take into account what other players may have bid or the current game 
score.    Note that expert players will go Nil with more challenging hands and will also try 
for finesses and signal preferred suits to their partner.    This expert style of play may be 
confusing to recreational players.    For an explanation of how expert players play, see 
Mastering Spades: A tutorial for advanced players.

Memory - This attribute assesses the players skill at remembering what cards have been 
played so far.    Card-counters will be able to take more chances guessing what the 
opponents cards are based on what they have played so far.    Expert card-counters will 
also remember better what suits their partner indicated a preference for and will try for the
finesse more often.

Predictability - This attribute assesses the players predictability.    Near-random players 
will catch other players off-guard with unexpected plays sometimes.    

Aggressiveness - This attribute assesses the players aggressiveness.    Aggressive 
players will generally bid Nil with tough hands, bid more tricks, try to go for the set more 
often, and may even set themselves in an effort to set an opponents Nil bid.

Customizing your own styles
You may also customize any of the computer players by selecting details on the player and 
clicking the Edit… button.    You may then change the name, bitmap, and/or all of the player 
attributes for the given player.    This means you can rename the players to your friends 
names, change their styles so you have a host of expert players, or even include a custom 
bitmap for yourself or another player.    To provide your own bitmap, include a 256-color BMP 
file the same size (and, ideally, the same palette) as the other face bitmaps in the Spades 
FACES subdirectory. Then, include the name in the picture field provided in the edit box.    If 
successful, you will see the picture change to your custom face and it will automatically be 
saved for future games.



    Customizing images and sounds
Championship Spades will allow you customize almost all the images and sounds used in the
game.    You may select from one of the several supplied images or sounds under the 
appropriate item under the Options menu.    For the more adventurous, you may also supply 
your own images or sounds by following the instructions below:

Adding your own custom table background
1) Create your own table background and save it as a 256-color Windows BMP.    Note that 
if you are on a 256-color system, your background may not look good if you dont use the 
same palette as the other backgrounds provided with the game.    Backgrounds can be any 
size although 64x64 is usually a good size.
2) Copy your Windows BMP file over to the TABLES subdirectory.
3) Restart Championship Spades and select the Tables… option.    The game will 
automatically detect your bitmap in the directory and show it along with the other bitmaps
for selection.    Select your bitmap from the dialog.

Adding your own custom deck pattern
1) Create your own deck pattern and save it as a 16-color (or 256-color) Windows BMP.    
Note that if you are on a 256-color system, your deck may not look good if you dont use 
the same palette as the other decks provided with the game. 
2) Resize the deck back to the same size as the other decks provided with the game.
3) Copy your Windows BMP file over to the DECKS subdirectory.
4) Restart Championship Spades and select the Decks… option.    The game will 
automatically detect your bitmap in the directory and show it along with the other bitmaps
for selection.    Select your bitmap from the dialog.

Adding your own custom player face
1) Create your own player face and save it as a 256-color Windows BMP.    Note that if you 
are on a 256-color system, your face may not look good if you dont use the same palette 
as the other faces provided with the game. 
2) Resize the face to the same size as the other faces provided with the game.
3) Copy your Windows BMP file over to the FACES subdirectory.
4) Select the details dialog for the player you wish to replace, and then select the Edit… 
button.    After the edit dialog appears, enter the picture name (no path) in the field 
provided.
5) Click OK and the players face will change immediately and be saved for future games.

Adding your own custom sounds for events
1) Create or copy your favorite WAV files over to the SOUNDS subdirectory.    You may also 
reference sounds in another directory by entering the full path in for the given sound.
2) Make sure WAV files on Windows 3.1 are less than 64,000 bytes in size.
3) Choose the Sounds… option and enter the filename under the appropriate events entry 
field.    If you do not give the full path, the sound must be in the SOUNDS subdirectory.    
The .WAV extension is optional.

Adding your own custom soundtracks
1) Create or copy your favorite MIDI files (with a .MID extension) over to the SOUNDS 
subdirectory. You may also reference sounds in another directory by entering the full path 
in for the given sound.    You probably already have several in your C:\WINDOWS directory.   
You can also simply disable the soundtrack by un-checking the box.
2) Choose the Sounds… option and enter the filename under the soundtrack entry field. .    
If you do not give the full path, the file must be in the SOUNDS subdirectory.    The .MID 



extension is optional.



    Will there be a multi-player network version?
The author DOES wish to produce a multi-player network version.    My goal for the first 
official release was to make an AWESOME standalone game with a solid, fun interface first.    
Now that that is mostly complete, I can address supporting multiple players.

Supporting network play is not that difficult and the game has already been architected with 
multiple players in mind.    However, their are numerous competing technologies right now 
for supporting network play so the author wishes to investigate and evaluate these.    You 
can help by letting the author know (at spades@dq.com):

1) Do you have Windows 95 or NT?    Do you expect to be getting it soon?
2) Would you prefer a DirectPlay (95 and NT only) version which would support modem, 
LAN, and Internet play on Microsofts free Internet game servers?
3) Would you prefer some other network protocol?    If so, which one?
4) Is modem play important to you?    Is local LAN play important to you?
5) How should players meet to form games?    IRC?    BBS Door?    An online service? 

It would depend on which method is supported for network play, but it likely that a network-
enabled version will be ready sometime early next year.    Registering and sending email 
are the best ways to convince me to hurry up with the network version…



    Registering
This game is NOT freeware.    The author has spent a great deal of time making a quality 
Spades game.    If you have enjoyed playing this, please register so you can help fund 
network play and other game variations.    You have have 15 days to evaluate this game, 
after which you must either register it or uninstall it.    To uninstall, simply remove the icon 
from your Games group and the SPADES directory.    The program is completely self-
contained.

If you register, you will receive a key to disable the nag screens (on both the 16-bit and 32-
bit versions) and a code to download the Mastering Spades advanced tutorial off the Web 
site.    If you provided your email address you will also be automatically notified of upgrade 
releases and your key will also work in these future versions.    If you want diskettes, you can 
also pay $9 more and I will ship you either the 16-bit or 32-bit version on diskette.    The Web
site always has the latest version (and allows you to switch between 16-bit and 32-bit 
versions) and making the diskettes is a pain for me, so only order diskettes if you REALLY 
need them.

You may conveniently register this product with any major credit card through the Public 
Software Library (PSL) for $39.      Ask to register Championship Spades, product #14669.    
You may contact PSL to order via several means:

1) Call 800-2424-PSL for ORDERS ONLY.
2) Call order to 713-524-6394 for questions or for outside the U.S.
3) Connect to their web site at http://206.109.101.6 and order online.
4) Email Internet order to 71355,470@compuserve.com
5) Email CIS order to 71355,470
6) Fax order to 713-524-6398.
7) Dial their BBS at 713-442-6704 and order online.

PSL notifies me within a week of your registration.    As soon as I receive notification, I will 
sent the registration key to you immediately via email or postal mail.    If you requested 
diskettes, please allow 4-6 weeks for delivery.    Once you receive your registration key, 
simply press the Enter key… button on the Register dialog under the Help menu.    Enter your
name and key EXACTLY as (including upper and lower-case) as they appear on your 
registration sheet.    All the nag screens will then be disabled and the registration dialog will 
show your name.

Please note that PSL is a registration service and shareware author organization and they 
have nothing to do with the author or the game itself.    If you have questions, need support 
of any kind, want to verify the status of your order, ask for volume discounts, to pay by 
check, or have any other kind of question, please Contact the Author directly.



    Contacting the author 

 

 

Christopher Williamson is the author of Championship Spades.    Christopher and his wife, 
Cynthia, together, along with their 130-pound German Shepard, provide custom user-
interface, graphics, and Web page consulting services through their consulting company, 
Dynamic Visual Solutions.

Both of us have played Spades for years both with friends and on the INN network.    
Christopher has also won several tournaments and taught several Mastering Spades classes 
as INNURed on the ImagiNation network (see www.inngames.com for more information).    

The best way to get support, tips, report a bug, get the latest version of this game, the 
status on network support, or for any other reason, is via the Internet.    You can reach the 
Championship Spades Web site at http://www.dq.com/spades.htp or send email to 
spades@dq.com.

If you are reporting a bug or suggesting an enhancement, please provide as much detail as 
possible about what you were doing before you encountered the bug, what OS you are 
running under, and details about your suggested game variation or type of network you 
would like supported.    Obviously, I am more prone to incorporate your requests if you 
register, but you may still make suggestions as an unregistered user.    Dont forget your 
name and email address so that I may reply with additional questions.

If charging is not convenient for you, you may also obtain support or register by mailing a 
check for the $39 to the address below.    If you want disks (and not just a key) mailed to 
you, please include an additional $9 to cover the cost of the media and shipping. The Web 
site always has the latest version and making the diskettes is a pain for me, so only order 
diskettes if you REALLY need them.    When you order make sure to indicate if you want the 
16-bit or 32-bit version.    Checks and correspondance can be sent to:

Christopher Williamson
Dynamic Visual Solutions
610 Parthenon Court
Lafayette, CO 80026-8805



    Version history

Features under consideration for future releases
1. Multi-player support for Internet, LAN, and modem play.
2. Add sounds for each player when game starts/selection?
3. Support for high/low jokers.
4. Support for 2S as high spade.
5. Improve computer play to even more aggressively sink Nils.
6. Improve computer play for cutthroat play? (suggestions appreciated).
7. Fix palette on table selection for 256-color displays.

Version 1.31 Production release
Released on October 19, 1996

1.    Nil scoring bug introduced in 1.3 version corrected and always added to the score.
2.    Slam & 10 for 200 bonuses from East/South now added properly to score, as above.
3.    Game play speed improved dramatically.    Normal should now suffice for most.
4.    Undo feature improved and now quite usable.    Please report if otherwise.
5.    All computer personality attributes can now be customized and saved.
9.    Two of clubs lead option now enforced properly.
10. Name prompt on startup option now properly saved and restored.
11. View last trick dialog now autosizes correctly on all systems.
12. Player minimum bid now always enforced.
13. Scoring dialog now always sizes properly and allows save, print, bug report.
14. Save/load buffer size increased to allow long paths and filenames.
15. Assign cards dialog update, sizing, and error-checking improved.
16. Install/uninstall instructions, requirements, and quick tips added to README.
17. Screen resizing on some machines now improved.
18. View faces option added to hide player faces.
19. Help file layout improved for readability.
20. Unchecking the MIDI soundtrack option stops playing immediately.

Version 1.3 Production release
Released on September 12, 1996

1. Corrected pallette bug introduced in 1.25 versions that caused colors to look wrong on 
256-color displays.
2. Icon installer and upgrades from previous Beta versions now works properly.
3. Improved security with tougher keys.    Early users have been sent new keys.
4. Prevented misplays (incl. trumps) when Ace played against opponent's Nil.
5. Prevented trumping by 4th player when opponent's Nil was winning trick.
6. Eliminated automated bug report that occasionally occured on some plays.
7. Blue color used throughout darkened to show better on dark grey backgrounds.
8. Sizing of score, player, and details dialogs should now work in all resolutions.
9. Scoring dialog formatting completely re-written for a nicer look.
10. Removed automated bug reporter entirely.    You can still manually use menu item.
11. Expert players will now cover Nil properly if they are 2nd to play on trick.
12. Expert players will no longer take a trick that a Nil player was already winning.
13. Expert players will stop sluffing tricks if Nil player already lost Nil.
14. Partner should no longer 'steal' tricks you have clearly already won.
15. Hopefully fixed some install problems for 16-bit users.
16. Increased delay on registration screen and annoyance for expired users.
17. Updated help file to include known issue with older video drivers and DirectX.
18. Completed Mastering Spades tutorial for registered users.
19. Completed a fair amount of personal and user testing of game.



Version 1.25 Cleanup releases
Released on August 26, 1996 and other dates

1. Expert computer players dont bid quite as aggressively as they did before.
2. Beginner computer players will no longer sometimes lead a Spade before they have been 
broken.
3. Changed the name of the executable to chmpsp32.exe and the ZIP archive to 
spades32.exe so it is easier to find for downloaders.
4. Added full keyboard support for bid, play, and option selections (see help file for details).
5. No longer warns about changing options when a new game is first started.
6. Allow entry of full-path for sounds so players can use sounds from other directories.
7. Improved and fixed several sound-entry bugs when disabling sounds and added a reset 
button.
7. Fixed (hopefully) occasional AutoRedraw failures and blank cards shown on 16-bit version.
9. Fixed save/load hands and MIDI soundtrack on 16-bit version.
10. Space bar now bids and plays using the hint provided by the hint option.    This will 
quickly finish each hand if you do not want to use computer playout.    This is used mostly by
me and is therefore not mentioned in the help or drop-down menus.
11. Updated bug report dialog to prompt for an explanation.
12. Resized printing to avoid going over right margins.
13. Rewrote most of the assign cards dialog to load existing hands in and to browse through 
players hands.
14. Added wait cursor (hourglass) for actions that take time on slower machines.
15. Added crosshair cursor for player and other selection dialogs.
16. Added context-sensitive help for all dialogs and updated the games help file.
17. Resized various things to run and look better on 640x480.
18. Tab order updated for keyboard navigation of option dialogs.
19. Fixed default size bug when maximized.
20. Added a warning when the take back feature is used (it still does not always work 
properly).
21. Removed crash when player attempts to print on a machine without a printer.

Version 1.2 Performance release
Released on August 18, 1996

1. Changed the way images are handled so it should be faster.
2. Greatly reduced resource usage which should prevent Autoredraw and out of memory 
errors on the 16-bit version.

Version 1.1 Patch release
Released on August 5, 1996

1. Fixed bad computer plays once and for all (I hope!).
2. Fixed incorrect scoring when calculating bag penalty.
3. Added extensive online context-sensitive help and improved help file.
4. Added a bug report feature to allow easy dumping of hand.
5. Fixed some cases when indicator or bid window was not drawn.
6. Allow use of numbers on keyboard for bid, play, and other selections.
7. Fixed 16-bit help and installer to include all needed files.
8. Removed save as default option, it now ALWAYS saves options.

Version 1.0 Initial release
Released on July 28, 1996

1. Computer now plays MUCH better based on skill and other traits.
2. Computer will try to sink opponents Nils by lead low, etc.
3. Popup registration reminder dialog on exit and pause.



4. Fixed bug with 2D being played more than once and # of cards off.
5. Added registration key entry screen and PSL info in help.
6. Count days since install and display in reg screen.
7. Put possible bid on statbar to help confused people.
8. Support saving, loading, and printing of hands and play history.
9. Right-click current players for play style.
10. Fixed bug where New game on bid loops.
11. Ignore all menu choices during startup.
12. Added a redeal hand option
13. Allow player to assign cards for each player.
14. Added a trick-taken animation.
15. Install now prompts for med/high skill levels.
16. Hashes are now colored to show overtricks.
17. Take back now works properly
18. Added an extensive help file for game and rules.
19. Added an extensive Mastering Spades tutorial for registered users.
20. Optimized play speed for computer playout.
21. Fix icon on game install.
22. Generally cleaned-up and smoothed game out.

Version 0.9 Beta release
Released on June 17, 1996

1. Computer now bids MUCH better based on skill and other traits.
2. Added view option to show last trick taken.
3. Installer now creates an icon and group.
4. Fixed Blind NIL bags counting incorrectly.
5. Fixed Game not ending at 500?
6. Confirm scoring/player options during mid-game.
7. Add confirmation for rebid and replay options.
8. If cut, draw 2 red lines in trickcard to show.
9. Resize text in help to be more even.
10. Refresh history on bid.
11. All cards should be checked & confirm on Show.
12. Cutthroat play scores not shown properly in statbar.
13. Size properly on small font.    Stretch startup.
14. Always save size and location.

Version 0.8 Alpha release (initial)
Released on May 25, 1996



    Known bugs and possible workarounds
The current release only has three known bugs and issues:

1) Table selection dialog does not display images with the proper palette on a 256-color 
display.    Workaround: Simply ignore the images and select by the names.    After the 
selection, the table will be displayed properly.    There is really nothing I can do about this on 
256-color systems since each background has its own 256-color palette…

2) The colors sometimes appear inverted or incorrect on 32-bit Windows 95 systems.    
Assuming you are using a 256-color or higher display (the game will look bad on a 16-color 
display), you should see nice faces on a wooden table background with a yellow notepad 
with dark blue writing for recording tricks bid and taken.    Note that previous versions also 
demonstrated this bug on many systems.    Now, it only appears on a few using outdated 
Win95 video drivers, usually in conjunction with DirectX (a Microsoft library supplied with 
several Windows 95 games and multimedia applications).    Luckily, it appears that one of 
two things has cured the problem for other users that have reported this:

    - Try switching to a hi-color (32,000 colors or more) mode.    Do this using the Display 
option in the control panel.    You may also wish to get the QuickRes powertoy from Microsoft 
that makes resolution changing easy without a reboot from 
http://www.dq.com/musthave.htp.
    - Obtain and install the latest video drivers for your particular video card from the 
manufacturer (most have web pages with the drivers available for free download).    Many of 
the drivers that come already installed with the computer are older than DirectX and most 
have made some recent upgrades to correct problems like this.    Since the driver depends 
on your video card, I can't direct you to a specific site.

3) The game sometimes crashes or has memory or resource problems on older 16-bit 
systems with 8MB or less.    Workaround: Increase your Windows swap file (see Windows 
Help), disable the sounds, or avoid player selection dialog, help file, and other extras to 
reduce memory usage.

4) On some systems running Microsoft Plus and using the Show window contents while 
dragging option, you may be unable to resize Championship Spades.    Workarounds: Disable 
this option under the Plus! tab in the Display settings dialog box or simply maximize 
Championship Spades using the icon or menu item.

Please, if the game crashes, or an expert computer plays poorly, please use the Report bug 
or bad play… option under the Help menu on the hand that caused the error or bad play.    
This will dump the player hands and play history out to C:\BADHAND.TXT.    You can then 
email that file to spades@dq.com ALONG WITH A SHORT EXPLANATION and I will have 
almost all the information I need to hopefully correct the error.    Do not forget to include 
which player made the mistake, what the mistake was, and either the round # or the 
misplayed card.    Please report bugs even if you are not registered.    I cannot improve the 
game without your feedback.    Particularly, since I would like to take pride in the computers 
ability…



    Spades Basics: Cards
Spades is a very exciting and challenging card game, less complex than Bridge, but more so 
than Hearts.
 
There are four players for a game of Spades, and each player is dealt 13 cards.    Each turn, 
they play one card.    The four cards that are played each turn are called a "TRICK".    That 
means there are 13 "TRICKS" each time a hand of Spades is played.    
 
The first card played in each trick is called the LEAD card & the suit of that card is the LEAD 
SUIT.    Players must always match the LEAD SUIT if they can.    
 
The high card in the suit played wins that given trick.    The winner of the trick gets to lead 
the
next card, which may be of any suit (except Spades, until they are broken, more on this 
later).



    Spades Basics: Trump
If a player does not have any cards of the LEAD SUIT then they can play any card in their 
hand; they do not have to play TRUMP if they do not want to (unless that is the LEAD SUIT).   
Spades are always TRUMP in the game of Spades.    
 
Any spade (the TRUMP suit) ranks higher than any non-Spade.    So, the highest Spade 
played on a non-Spade lead will take that trick. 
 
For example: if the AH was led and you have no hearts, you may win the trick by playing the 
2 of Spades.
 
You can not lead Spades until they are "broken"; that is until they are played on a non-Spade
lead.    Once that happens, you can lead with a Spade.



    Spades Basics: Bidding
Thirteen cards are dealt to each of the four players.    You must decide how many of the 
thirteen 
possible TRICKS you think you can take.    
 
To do this, look at how many high-ranking cards you have.    An Ace will usually take a TRICK. 
If you also have the King in that suit, you can usually count on taking that TRICK, too.    Also 
check to see if you have any short suits (only a few of any one suit).    As soon as those cards
are gone from your hand you can start to play TRUMP (Spades) on those tricks.
 
When it is your turn, a window appears on your screen that has NIL and 1 through 13 Spades
on it.    Click on the card that equals the number of TRICKS you think you can take (NIL being 
zero).    

If you want some guidance, you can use the hint function (under the Practice menu or press 
Ctrl-H).    The computer will display what it would bid in the status bar.



    Spades Basics: Playing
After the bidding is completed, the person to the left of the dealer leads the first card.    Any 
card except a Spade may be led.    Remember that spades cannot be led until "broken".
 
An arrow will always point to the current player.    When it is your turn, simply click on the 
card you want to play.    It will then be placed in the playfield in the center of your screen 
with the other players cards in the current TRICK.
 
Whoever wins the TRICK will lead for the next hand.    Play continues until all 13 TRICKS are 
taken.    As play progresses, the number of TRICKS taken by each player is shown in the 
trickcard in the lower right-hand corner.    Remember in partnership Spades, both players 
tricks count together toward the team total.
 
You MUST follow suit, if you can.    If you do not have any cards of that suit, and so cannot 
follow suit, you may play any card including TRUMP (Spades).    You do not have to play 
trump if you do not wish to do so.    
 
If you want some guidance, you can use the hint function (under the Practice menu or press 
Ctrl-H).    The computer will display what it would play in the status bar.



    Spades Basics: Scoring
 
Scoring in Spades is determined by how many TRICKS you take versus how many TRICKS 
you said you would take.
 
If you take as many TRICKS as you bid, then you score 10 points for each trick taken.    So if 5
tricks are bid and 5 tricks taken, you would get 50 points.
 
If you do not make your bid, you lose 10 points for each one you bid, no matter how many 
tricks you actually end up taking.    So, if you bid 5 and get 4, you lose all 50 points, not just 
10.    
 
If you bid NIL (zero tricks) and make it, you score 100 points.    However, if you take any 
tricks at all, you lose 100 points!    More on NILs later.
 
A game is typically played to 500.      Note that all scoring amounts are adjustable under the 
Options…Scoring menu, the above numbers are the default score values.



    Spades Basics: Game Variations and Sandbags
Championship Spades offers many game variations found under the Options…General 
menu.    The default game variation is partnership spades with sandbags.    
 
In PARTNERSHIP spades, you and your partner (the computer player across the table from 
you), bid and play together.    This means that you will help one another, not take each 
others tricks, protect your partners NIL bids, etc.    In CUTTHROAT spades, it is every man for 
themselves.    This means that every player bids and plays separately.    CUTTHROAT is also 
generally more competitive as players try to SET others bids more aggressively.
 
SANDBAGS were originally put into place to prevent people from always underbidding their 
hand.    This is also used to make it difficult for people to deliberately bid low and make you 
bid too high.
 
Any trick over the ones you bid are called SANDBAGS.    Once you have collected 10 
sandbags, over several hands, 100 points are deducted from your score.    In PARTNERSHIP 
spades, bags are counted together toward the team total.



    Spades Basics: Going Nil
One of the aspects of Spades that make it unique is the ability to bid NIL.    This means you 
will not take any tricks.    This is harder than it might sound as your opponents will be 
deliberately trying to SINK you and force you to take a trick by playing 2's...
 
For beginners, a good NIL hand has no Aces or Kings, lots of low cards, and no more than 3 
low Spades.    Keep in mind that your partner can (and should) protect you, so if he bids high,
you can go NIL with a tougher hand.    Under CUTTHROAT, NIL is much harder to get since 
you have no partner to help prevent you from taking tricks.
 
BLIND NIL is a desperation bid if you are losing and your opponent could win the game next 
hand.    Before you even SEE your cards, you can go BLIND NIL.    If you make it, you gain 200
points, if not, you lose 200 points.

I cover much more about this fascinating bid in the Mastering Spades tutorial (only available 
to registered users) along with many other useful topics to more experienced players.



    Mastering Spades 1: Bidding better and signaling
Sorry, the advanced tutorial only comes with the registered version. 



    Mastering Spades 2: Playing to maximize tricks
Sorry, the advanced tutorial only comes with the registered version. 



    Mastering Spades 3: Setting them AND minimizing bags
Sorry, the advanced tutorial only comes with the registered version. 



    Mastering Spades 4: Review and quiz
Sorry, the advanced tutorial only comes with the registered version. 



    Mastering Spades 5: NIL: bid, play, protect, sink
Sorry, the advanced tutorial only comes with the registered version. 



    Mastering Spades 6: Advanced end-game strategies
Sorry, the advanced tutorial only comes with the registered version.



    Mastering Spades 7: Test of Spades Mastery
Sorry, the advanced tutorial only comes with the registered version.




